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Course Overview
Objectives:

1. Develop an understanding of DNP 3.0 on a protocol
level.

2. Analyze typical DNP messages.
Prerequisite:

Basic understanding of SCADA concepts, network protocols
and data communication.

Reference Materials:
» DNP DPA Configuration Guide (B021 0CG)
» DNP DPA Functional Specification (B021 OFS)
» DNP DCA Configuration Guide (B023 0CG)
» DNP DCA Functional Specification (B023 OFS)
» DNP Basic 4 Documentation (944-0007)

4
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Recommended Schedule

Day 1
» Introduction to DNP V3.0
» DNP vs. IEC 870-5
» Using DNP / The GE Implementation
» Configuring DNP
» Introduction to DNP Message Structure

Day 2
» Conclusion of DNP Message Structure
> DNP Message Labs %%’é
(=
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Section 1 — Introduction to DNP

Objectives:
1. State the origin of the DNP protocol.
2. Explain the basic application of DNP protocol.
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Section 1 — Introduction to DNP — cont.

Highlights
» Distributed Network Protocol (DNP)
» Open Systems Protocol Stack

» Recommended by IEEE for RTU to
IED messages

» Based on IEC 3-layer version of 7-
layer OSI model

» Developed by Harris Energy Control
Systems (now GE Energy)

» Controlled by DNP Users Group

Physical
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Section 1 — Introduction to DNP — cont.

DNP Features

» Asynchronous, code transparent
» Addresses over 65,000 devices

» Addresses over 4,000,000,000
data points of each data type per
device

» Broadcast Messages
» Configuration/File Transfer

» Time of Day and Date
Synchronization

» Time-Stamped Event Data
» Data Priority Levels (classes) Physical
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Section 1 — Introduction to DNP — cont.

DNP is Interoperable

» Based on IEC 870-5 standards

» Implemented by many vendors; list
growing daily

» Specified by many customers
worldwide

» Not owned by any one company

» Users have choice of vendors

10

SSD0006 Revision5 © 2004 General Electric Canada, All Rights Reserved imagination at work @



Section 1 — Introduction to DNP — cont.

DNP is Robust
» Intended for low-to-medium speed %
/

media
» 16-Bit data link CRC every 16 octets
» Hamming distance of 6
» Optional data link confirmation N
» Optional application confirmation %
» Very efficient for a layered protocol

11
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Section 1 — Introduction to DNP — cont.

DNP is flexible:

» Object-based application layer

» Objects provided for most generic
data formats

» Add new objects via DNP Users
Group

» Devices can choose which objects
to support

» Standard implementation subsets
defined

12
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Section 1 — Introduction

Fits a Variety of Networks
» Multiple operating modes
» Poll-Response
» Polled Report-by-Exception
» Unsolicited Response
> Peer-to-Peer

» Layered protocol allows mix-and-
match

» Suited to large distributed systems
» Simple implementations for IEDs

» Complex implementations for data
concentrators

» Permits Multiple Masters
» Encourages Distributed Intelligence

13
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Section 1 — Introduction to DNP — cont.

DNP Users Group
» Controls DNP as of November 1993

» Members include individuals from
utilities and vendors

» Meet twice per year
» Evaluates modifications to the protocol

> Evaluates modifications to
documentation

14
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Section 1 — Introduction to DNP — cont.
Review Questions

What IEC standard is DNP based on?
Name 5 features of DNP?
Who controls DNP?

How many devices can DNP address?

a H~ L D E

How many data points can DNP address?

15 ®
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Section 2 — DNP vs. 870-5

Objectives:
1. Describe the features of the IEC 870-5 standard.
2. State the differences between DNP and the IEC standard.

17
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Section 2 — DNP vs. 870-5 — cont.

The IEC 870-5 Standard:
» Specifically designed for

i ~ati Presentation
telecontrol applications ——
> Uses the 3-layer EPA model ession
based on the 7-layer OSI model Transport
Network

» Has short reaction times when
used in noisy environments at
low communication speeds

Seven Layer vs. Three Layer:

» Only the Application, Datalink
and Physical Layers are used

» Reduces communication
overhead providing a more
efficient protocol for low-to-
medium speed media

18
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Section 2 — DNP vs. 870-5 — cont.

Application Layer

» Determines the format and
characteristics of the data

Datalink Layer

» Confirms data integrity and
extracts user data from the
frames

Physical Layer

» Provides a method of transport
for the data frames

19
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Section 2 — DNP vs. 870-5 — cont.

Physical Layer:
» Converts media signaling
» Provides isolation from media
» Synchronizes bits
» Adds / removes frame synch
» Detects media states
» Octet oriented (Byte)

» Uses FT3 Format
» 1 Start
» 1 Stop
» 8 Data
» No parity

20
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Section 2 — DNP vs. 870-5 — cont.

Data Link Layer:
» Controls access to the physical layer
» Assembles/disassembles frames

» Sends/receives application data
transparently

» Detects frame errors

» Provides error recovery procedures
» Recognizes addresses

» Handles different size frames

» Performs physical layer switching
functions

» start/stop switched network
connections

» switch over for failure recovery

21
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Section 2 — DNP vs. 870-5 — cont.

There are 3 service classes:

» Service Class S1 - SEND/NO REPLY

» transmit message; neither ack nor
answer is required

» used for simplex (one-way) data
transmission

» data with errors detected is discarded

» Service Class S2 - SEND/CONFIRM

» transmit message; acknowledgment
requested

used for spontaneous data
transmissions

good data is acknowledged

If receiver is unavailable, a NAK will
be returned

data with errors detected is discarded

YV VYV V

22
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Section 2 — DNP vs. 870-5 — cont.

Three Service Classes — cont'd

» Service Class S3 - REQUEST/RESPOND
» used for "read" operations

» receiving station responds with
requested data if available

» If no data available, a NAK will be sent

requests with errors detected are
discarded

A\

23
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Section 2 — DNP vs. 870-5 — cont.

3 main types of Frame Formats:

» FT1 - broken into two sub types: FT1.1
and FT1.2

» adds a start, stop and parity bit to each
octet, including the header octets

» FT1.2 includes a single 8 bit CRC

> FT2

» frame begins with a fixed length
header starting with one of two 8 bit
start characters, sequence of data
blocks containing up to 16 data octets

» each data block, including header has
8 bit CRCs

24
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Section 2 — DNP vs. 870-5 — cont.

3 main types of Frame Formats - Cont'd

» FT3
» each frame begins with a fixed length
header starting with one of two 16 bit
start characters, at the beginning of a
sequence of data blocks containing up
to 16 data octets

» each data block, including header, has
16 bit CRCs

25
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Section 2 — DNP vs. 870-5 — cont.

Un-balanced mode:

» Typically used for Master-Slave systems, i.e. polling (multi-drop)
environments:

» the Master (always primary) generates <requests> and receives
<confirmations>

» the Slave (always secondary) receives <indications> and
responds with <responses>

» requests which can be sent to the Data Link (from the Application
Layer):
» open a communication channel
» close a communication channel
» send a message
» receive a message, a transmit status indication or a time-out
Indication
» perform a control request
26
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Section 2 — DNP vs. 870-5 — cont.

Balanced Mode:
» Used by combined systems, i.e.., where either station may initiate
data transfers:
» is best suited for point-to-point, full duplex systems

» the Master/Slave relationship is relatively unimportant, as
either station can assume the primary role at any time.

» the station which initiates the transfer (primary) generates
<requests> and receives <confirmations>

» the station which responds (secondary) receives
<indications> and responds with <responses>

27
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Section 2 — DNP vs. 870-5 — cont.

Application Layer:

» The user processes communicate with the
application layer through Application Functions

» Several Application Functions may be
communicating at one time

» Application Processes can have a Primary
Application Function or a Secondary
Application Function

» Application Functions use Service Primitives
to pass requests and responses to/from the
communication services (data link layer)

28
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Section 2 — DNP vs. 870-5 — cont.

APPLICATION (USER) PROCESSES

Function 1 | Function 2| Function 3 | Function 4 | Function n

APPLICATION LAYER

DATA LINK LAYER

PHYSICAL LAYER

TRANSMISSION
MEDIA

29
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Section 2 — DNP vs. 870-5 — cont.

Four types of Service Primitives:

» <service>.request

» the primary application function initiates a request via the
communication services (data link layer)

» <service>.indication

» comm. services deliver the indication to the secondary
application function

» <service>.response

» the secondary application function responds to an indication
from the comm. services

> <service>.confirm

» comm. services deliver the secondary's response to the
primary application function

30
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Section 2 — DNP vs. 870-5 — cont.

Service Primitives

Unconfirmed
App. Services Communication
Services |
service.request | |
PrlmawApphcanon | ~ - AI service.indication Secondary Application
Function — Function
l l
l l
Confirmed | |
App. Services service.request | |
— e — service.indication
I - H
Primary Application _ Secondary Application
Function , _ | | service.response Function
service.confirm e C——
- I
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Section 2 — DNP vs. 870-5 — cont.
Application Functions defined in IEC 870-5-5

>

V.V VYV V VYV V VYV V

32

Initialization

Data Acquisition by Polling

Cyclic Data Transmission

Acquisition of Events

General Interrogation

Clock Synchronization and Delay Measurement
Control Commands

Transmission of Integrated Totals

Parameter Loading (configuration file transfer)
Specific messages defined in IEC 870-5-101
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Section 2 — DNP vs. 870-5 — cont.

Layer Interaction

Master Physical Layer Data Link Layer Application Layer
Station | I
REQUEST §  DATA CORRUPTED I |
I DATA LINK DETECTS BAD CRC
Data Discarded I
NO | (Data Discarded)
RESPONSE MESSAGE OK. DATA LINK
I REMOVES HEADER AND CRC I INDICATION
—
|
DATA LINK ADDS HEADER RESPONSE

AND CRC

DATA LINK RESPONSE TIMEOUT.I

MESSAGE LOST
RETRY PREVIOUS MESSAGE | NOTIFY APPLICATION

I LAYER OF SUCCESS
33
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Section 2 — DNP vs. 870-5 — cont.

Physical layer:

>
>

Same as IEC EPA, plus RS-485
Real implementations often over radio systems

Data Link layer:

>

YV V V V VYV VY

34

Address field includes both source and destination

Uses frame format FT3 ONLY

Variable length frame type ONLY

Balanced procedures ONLY

Collision avoidance at physical layer for unsolicited

Max. frame length 255 octets

Various confirmation services

Balanced procedures don't use REQUEST/RESPOND very much
Asynchronous only
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Section 2 — DNP vs. 870-5 — cont.

Application layer:

» Uses the same general concepts:
» layered protocol
» application primitives: request, respond, indicate, confirm
» Includes most of the same (SCADA) functions:
initialization
polling/interrogation
acquisition of events
clock synchronization
freezing data
control outputs
file/configuration transfer

» Actual message format is quite different

VYVVYVYYVYVY
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Section 2 — DNP vs. 870-5 — cont.

Collision Avoidance — DNP:

» DNP V3.00 uses IEC 870-5 Balanced
Procedures

» Any device can theoretically transmit at
any time

“ 4-Wire

» 4-Wire Direct Connection
» No Collisions are possible. One pair

for TX and one for RX

» 2-Wire Direct Connection

» Collisions are possible. One pair
shared for TX and RX 2-Wire

36
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Section 2 — DNP vs. 870-5 — cont.

Collision Avoidance — DNP Implementation
Half Duplex 2-Wire

» All stations use RTS to turn on carrier of
modem when they wish to transmit

» No station transmits while DCD is asserted

» Slaves wait variable time delays to transmit
after DCD is clear

» Master has control of the circuit by always
having the smallest delay

no oo

2-Wire Half Duplex
Multi Drop

37
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Section 2 — DNP vs. 870-5 — cont.

Collision Avoidance — DNP Implementation
Half Duplex 4-Wire

» This format does not support collision
avoidance because slaves cannot see
each other's carriers.

» Collision Avoidance Algorithm will not work

» Users have been able to make systems
work by using extended time delays to
reduce probability of collision

2-Wire Half Duplex
Multi Drop

38
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Section 2 — DNP vs. 870-5 — cont.

Transport Functions — DNP
Implementation

» When Application Messages are too
large for a single frame a Pseudo
Transport Layer provides segmentation
services

» One Transport Service Data Unit (TSDU)
IS broken into several sequenced
Transport Protocol Data Units (TPDUs or
segments), before it is sent to the Data
Link Layer for transmission

» Multiple are TPDUs from the data link
and reassembled into one TSDU

» A one-byte header is added between
application and data link headers to do
this.

39
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Section 2 — DNP vs. 870-5 — cont.

“Real” Transport Layer vs. DNP:

» A'real" transport layer:
» Is terminated only at each end of the

message path

» provides its own
reliability/confirmation

» has its own transport layer

addresses

» The DNP Transport Function:
» is terminated at the end of each data

link

» uses the data link layer addresses

and reliability

» however, not data link layer - first
byte of user data

40
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Transport
Function
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HEADER
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Section 2 — DNP vs. 870-5 — cont.

Fragmentation
» Performed at Application Layer
> Allows multiple responses to a single TFra”SPO” Application
unction Layer
requeSt SEGMENTS FRAGMENTS

» Sets upper limit on size of buffer needed
on receive side

» Data can't be broken just anywhere -
each fragment must be separately
parseable DATA

» Performed much more rarely
» Typical limitis 2048 bytes

HEADER

N\

DATA

41
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Section 2 — DNP vs. 870-5 — cont.

Physical Layer

FRAME

y

FRAME

»

FRAME

A 4

Data Link Layer
SEGMENTS

Transport
Function

HEADERS

USER DATA

CRCS

HEADERS

USER DATA

CRCS [ ]
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Section 2 — DNP vs. 870-5 — cont.

Confirmation Services — DNP
Implementation:

» Data Link Confirmation:

» confirms frame transmission END/CONFIRM
» used to confirm that a single frame was \
received

_ o o CONFIRM
» used to provide reliability on noisy links /

» sending data link layer may choose to

rery END/CONFIRM
» single-bit sequence number ensures no

dup_llcates . CONFIRM
> retries are efficient because frames are /
small

43
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Section 2 — DNP vs. 870-5 — cont.

Data Link Confirm

1 Send

Confirm
2. Send

Confirm

Garbled

2 Send

Confirm

44 Sendtmmrﬂames.ThesecondfnﬁneconﬂnnaﬂonisIosL
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Section 2 — DNP vs. 870-5 — cont.

Confirmation Services — DNP
Implementation:

» Application Layer Confirmation:
» confirms message fragment

.. END/CONFIRM
transmission \

» application may or may not support

retries ‘%

» each frame of each fragment may also
be retried several times by the Data

Link layer! %
» application confirms recommended only
o y

» multi-fragment responses
» fragments containing event data

45 » unsolicited responses
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Application Layer Confirm

Section 2 — DNP vs. 870-5 — cont.

MASTER SLAVE
Request
_ NOT
(Confirm) I RECOMMENDED
(— —— — =
Response
ONLY WHEN
i _ NEEDED
e —— (Confirm) DON'T RETRY

Unsolicited Response

— —
~—>

<
Qe

[ —
T — — —_— (Confirm)
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USUALLY NEEDED
RETRIES OK
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Section 2 — DNP vs. 870-5 — cont.
Review Questions
1. How many layers does DNP use? Describe them.

2. What are the 4 Application Layer Primitives used In
DNP? Describe them.

3. Describe Collision Avoidance. What formats support
it? What formats do not?

4. What is the difference between Fragmentation and
Segmentation?

5. What is the difference between Data Link Confirms
and Application Layer Confirms? When should each
be used?
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Section 3 — Using DNP 3.0

Objectives:

1. Use DNP 3.0.

2. List the DNP Subsets.

3. Describe the GE implementation of DNP.
4

Explain how to configure a GE Automation Product to communicate
using DNP.

49
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Section 3 — Using DNP 3.0 — cont.

Methods of retrieving Data:
» Poll for Classes of Data
» Class 0 non event, static data
» Class 1, 2, 3 event data
» Poll for any variation of an object type
» Poll for specific variations or ranges
» Unsolicited responses
> File transfer
» Private registration objects

50
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Section 3 — Using DNP 3.0 — cont.

Communication Techniques:

» Quiescent Operation:

» all unsolicited responses, Master
never polls

» best with many devices with small
point counts
» Unsolicited Report-by-Exception:
» unsolicited responses for events
» Master occasionally checks integrity
of database
» Polled Report-by-Exception

» event polls interspersed with integrity
polls

» no unsolicited operation

» Polled Static Operation
» only integrity polls performed.
» no event polling

no oo
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Section 3 — Using DNP 3.0 — cont.

Output Options:

» Select/Operate or Direct Operate
Function Codes

» Direct Operate - No Ack for broadcasting
» Multiple Outputs in the same message
» Control Relay Output Block options:
Trip

Close

Latch On/Off

Pulse On/Off

Pattern Masks

Repeat Counts

Time Intervals

» Analog Output Blocks (setpoints)

VVVYVYVY
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Section 3 — Using DNP 3.0 — cont.

Subset Definitions:

» DNP is a large protocol

» No vendor currently implements it all

» Customers need a simple way to specify compatibility
» Vendors need guidelines on what to implement

General Rules:

» Master cannot transmit any requests not defined for the level - may
accept additional responses.

Slave cannot transmit any responses not defined for the level - may
accept additional requests.

>
» Vendor must record all differences in a Device Profile Document.
» Any differences beyond these rules must be configurable.

53
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Section 3 — Using DNP 3.0 — cont.

DNP-L1:

» Suggested for the simplest Master Station and IED applications

» Master acquires data from Slave by either:
» Class Data Polls
» polls for variation O of output objects
» unsolicited response from Slave

» Master will not request any specific data objects
» Includes most basic data types

» No frozen objects

» Binary inputs only time-stamped objects

» Time synch, delay measurement if needed

» Limited subset of qualifiers

» Cold Restart and Writes to Restart IIN

54
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Section 3 — Using DNP 3.0 — cont.

DNP-L2:

» Restricted implementation for Master to smaller remote devices:
» meters, reclosers, small RTUs
» intended for similar applications as L1

» Has a few more features:
» Freeze requests
» Frozen counter objects (not Analogs or Binary)
» Reads for variation O of most objects
» Reads for all variations of Binary Inputs
» Unsolicited responses with static data

» This is the level recommended by IEEE RP-1379.

55
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Section 3 — Using DNP 3.0 — cont.

DNP-L3:

» Suggested for Master to medium sized Slave devices:
» RTUSs, concentrators

» Much larger range of Objects, Variations, Function and Qualifier
codes

» Read Reguests of specific objects and variations
» Enable/Disable Unsolicited Responses
» Assigning objects to classes dynamically

56
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Section 3 — Using DNP 3.0 — cont.

Not Defined in Any Subset:
Frozen Counters with Time of Freeze
Counter and Analog Events with Time
Frozen Analog Inputs and Events
Storage Object
Device Profile Object
Private Registration Objects
Application Identifier Objects
File Identifier Objects
Floating Point and BCD Objects
Function Codes:
» FREEZE WITH TIME (ACK & NO ACK)
» START/STOP APPLICATION
» SAVE CONFIGURATION
» WARM RESTART
> INIT DATATO DEFAULTS

VVVVVVVVYY

57
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Section 3 — Using DNP 3.0 — cont.

GE Implementation — General:

» Any DNP implementation will support a subset
of the total protocol described in the DNP V3.0

Basic 4 Documentation set (977-0007)

» The applications included in the GE
Implementation are:

>

YV V V V

58

B021 — DNP DPA

B023 — DNP DCA

BO15 — Bridge Manager

B013 — DNP Serial Data Link
B052 — DNP Ethernet Data Link
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Section 3 — Using DNP 3.0 — cont.

BO23 DNP DCA

» Communication between RTU and sub-remote or
IED - The Data Collection Application:

> allows the RTU to act as a "Master" to one or more
remote devices

» 1s a component of the Application Layer of the EPA
Model

B0O23 DNP DPA

» Communication between RTU and Master Station
— The Data Processing Application:

> allows the RTU to act as a “Slave" to one or more
master stations

» is a component of the Application Layer of the EPA
Model

59
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Section 3 — Using DNP 3.0 — cont.

B0O13 DNP Serial Data Link

» Services for software applications to send and
receive messages using DNP V3.0 protocols are
provided by the Data Link Software

» Provides control of a serial physical layer

B0O52 DNP Ethernet Data Link

» Services for software applications to send and
receive messages using DNP V3.0 protocols are
provided by the Data Link Software

» Provides control of an Ethernet physical layer

60
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Section 3 — Using DNP 3.0 — cont.

BO15 Bridge Manager

» EPA Model does not provide a network layer for
routing

» Bridge Manager provides this function without
adding a header to the data

» Provides a connection between the DataLink and
Application Layers

61
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Section 3 — Using DNP 3.0 — cont.

Communications Architecture

Master/Host

Requests RTU
from R
Master SOPONSe Report Data Events
Data Events to WIN

Requests Receive DPA

Requests Data
Poll, Output Response
Requests
Device

62
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Section 3 — Using DNP 3.0 — cont.

Communications Architecture

Bridge Manager
Data Link

Master/Host
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Section 3 — Using DNP 3.0 — cont.

Communications Architecture

64
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Section 3 — Using DNP 3.0 — cont.

Communications Architecture

Bridge Manager
Data Link

Master/Host

SSD0006 Revision5 © 2004 General Electric Canada, All Rights Reserved imagination at work @

65



Section 3 — Using DNP 3.0 - Configuration

There are several applications that must
be configured to use DNP:

» DNP DCA (B021) or DNP DPA (B023)
» Bridgeman (B0O15)
» DNP Serial Datalink (B013).

DNP operates using a 3 layer model called
the Enhanced Performance Architecture:
» Application Layer (DNP DCA or DNP
DPA)
» Datalink Layer (DNP Datalink)

RTU #1

Data Data

In QOut

Y

Applicationg Layer

Dataiink Layer

» Physical Layer (physical media)

L EssssEsEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE

-. ...... P.hysje.al..h.ay.er ......................

» Pseudo Network Layer (BridgeMan)
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Section 3 — Using DNP 3.0 — Configuration

— cont.
Device Communication

Device #1 Device #2

Data Data Data Data

In Out In Out

A A
Y | Y
Application Layef Application Layef
Data Link Lgayer Datai Link Layer
N =1 o 12T [o- | I - 1=
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Section 3 — Using DNP 3.0 — Configuration

— cont.
Device Communication

Multiple Data Links

Device #1 Device #2 Device #3
Data Data Data Data Data Data
In  Out In  Out In  Out
Appligation Layef | vAﬁbvii'c'aggﬁ'L.éye.r | Application Layef
| B;idgeMz:\n | | f"‘ :‘“I;ridgeMarhl"': "’: | | B;idgeM;m |
| Datai_ink LeéyerA | | Data;Link LaiyerA || DataELink La:yerB | | Datai_ink Layer B |
| T LT S SO |
| Y £ V2 1) 7T - S : |
| |

68

SSDO0006 Revision5 © 2004 General Electric Canada, All Rights Reserved imagination at work @



Section 3 — Using DNP 3.0 - Configuration

10 = Application Address

1 = Application Address

100 = DPA address

101 = Master address

DNP DCA B023_DCA DNP DCA B023_DEV

10 BO13 O A
100 BO13 1 64

I'

Bridgeman LAT BO15_LAT

i

1 B013 0 1
101 B0O13 1 65

Bridgeman RAT B015_RAT

L COM1 9600 Handshaking =
COM2 19200 Handshaking

DNP Datalink BO13_CNL

DNP IED

|IED Address = 1
RTU Address = 10

69

Master Address = 101
RTU Address = 100

DNP DPAB021_CFG

Other Devices

DNP Master
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Section 3 — Using DNP 3.0 - Configuration

_ - = 100 = DPA address
10 = Application Address 1 = Application Address

101 = Master address

DNP DCA B023_DCA DNP DCA B023_DEV DNP DPA B021_CFG
— 10 B013 O 32 -\'- 1 B013 0 5 —
100 BO13 1 C8 101 BO13 1 C9
Bridgeman LAT BO15_LAT Bridgeman RAT B015_RAT
|

L COM1 9600 Handshaking =

COM2 19200 Handshaking
DNP Datalink B013_CNL In RTU
DNPIED DNP Master Other Devices
|ED Address =5 Master Address = 201
. RTU Address = 50 RTU Address = 200
7
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Section 3 — Using DNP 3.0 — Configuration
— cont.

Once the applications are configured, you
must reserve space in the database for the
date generated by the DNP applications.

DNP DCA will require you to reserve
space for both PSEUDO points and the
data you are collecting for the IEDs.

Global pseudo points are associated with
every device being polled by an instance
of the DCA and only need to be configured
once:

» 3 Global DI

» 9 Global DO

71 * Application Version Dependant. See Configuration Guide for Details.
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Section 3 — Using DNP 3.0 — Configuration
— cont.

Device pseudo points are only associated
with one device and need one set to be
configured per device:

» 16 Per Device DI

» 10 Per Device DO

» 5 Per Device Al

The application data is stored in the
following order:
» Global Pseudo Points
» Device 1 Real Data
» Device 1 Per Device Pseudo Points
» Device 2 Real Data
» Device 2 Per Device Pseudo Points

72 * Application Version Dependant. See Configuration Guide for Details.
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Section 3 — Using DNP 3.0
Review Questions

1. Describe 5 methods for transferring data.

2. Describe the 4 communications technigues.

3. Outline the differences between the three DNP
Subsets.

4. What are the five applications in the GE
Implementation of DNP and what are their
functions?

5. Sketch and describe the communications

architecture in the GE Implementation of DNP. @

SSD0006 Revision5 © 2004 General Electric Canada, All Rights Reserved imagination at work @

73



DNP
Configuration
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DNP Configuration

Objective:

The objective of this lab is to create and test an RTU
configuration that will allow a GE RTU to communicate
using DNP.

L
A
B

Introduction:
In this lab, the student will create and test a DNP 1
Configuration. The following slides will outline the
configuration requirements.

This configuration will be used in subsequent labs.

75
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DNP Configuration

Meter Requirements

Configure the RTU to communicate with a meter using

the following specifications:
» DNP address of the meter = 1
» DNP address of the RTU = 10
» 10 DI Points, 10 Al points, 10 DO Points
» Poll for events every 2 seconds and the database
every minute
» Use Coma3, 9600 baud, no flow control

76
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DNP Configuration

Master Requirements:

Configure the RTU to communicate with a master

using the following specifications:
»DNP address of the Master = 10
»DNP address of the RTU =1
»10 DI Points, 10 Al points, 10 DO Points
»All data Class 1, no unsolicited responses
»Use Com4, 9600 baud, no flow control

77
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DNP Configuration

Connections and Testing:

Use a null modem cable to connect Com3 and Com4
of the RTU. Check to ensure communications is

established with the following tests:
»Wesmaint Device Status Display
»All data is ONLINE in the Wesmaint Data Display
»SA COM3 1
»SA COM4

L
A
B
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Section 4 — Message Structure

Objectives:
1. Describe the DNP Message Structure.

2. Parse DNP messages.

80
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Section 4 — Message Structure — cont.

FT3 Frame Format

> Header has fixed length of 8 octets. However, three of these
octets are not considered user data.

> Blocks of user data have a maximum length of 16 octets.

» Aframe has a maximum length of 255 octets of user data not
Including 2 octet CRC

BLOCK 0 BLOCK 1 BLOCK n
HEADER USER DATA USER DATA
A — FRAME

81
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Section 4 — Message Structure — cont.

Transport Functions

> Required because some messages will not fit in the 255 octets of
user data allowed.

> Breaks down large messages to be transported.

» Assembles large messages that are received.

» Uses a sequence number to track data.

BLOCK 0 BLOCK 1 BLOCK n

HEADER I USER DATA USER DATA

(Pseudo) Transport Header

82
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Section 4 — Message Structure — cont.

Typical Message Layout

LT ] ] ] | B sLock o

DATA LINK HEADER - 8 octets BLOCK 1

x| fapedoajopiqve | | 1 1 | | | IGE

TRANSPORT FUNCTION HEADER BLOCK 2

HEEEEEEEEEEEEEENE

................... BLOCK n

HEEEEEEEEEEEEEENE
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Section 4 — Message Structure — cont.

Data Link Header

»The data link header is used on the data link layer of the protocol to
ensure proper routing and error checking of a message.

Start LEN CTRL Destination Source

Start octets are always as shown.
84
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Section 4 — Message Structure — cont.
Data Link Header

> The ‘Start’ field always consists of the two octets 05 64 (hex)
indicating the start of a message.

> The ‘Length’ field indicates the total number of octets in a message,
excluding the START, LEN, and CRC octets.

»>The ‘Frame CTRL' field ensures that the frames are delivered
properly and in the correct order.

Start LEN CTRL Destination Source

Start octets are always as shown.
85
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Section 4 — Message Structure — cont.

Frame Control Octet

DIR =X If the direction bit is set, message is sent by the
master.

PRM =Y If the PRM bit is set, message is sent by the primary.

FCB =Z The FCB (Frame Count Bit) toggles state each time the
primary sends a message.

FCV =N If the FCV (Frame Count Valid) is set, the FCB is
enabled, if not it is ignored.

FUNCTION CODE

86
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Section 4 — Message Structure — cont.

Primary Function Codes

Function Frame Type Service Function
0 Send - Confirm Expected Reset of remote link

1 Send -  Confirm Expected Reset of user process

2 Send -  Confirm Expected Test function for link

3 Send -  Confirm Expected User Data

4 Send - NoReply Expected | Unconfirmed User Data
9 Request - Respond Expected | Request Link Status

87
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Section 4 — Message Structure — cont.

Secondary Function Codes

Function Frame Type

Service Function

Confirm ACK - Positive Acknowledgment

Confirm NACK - Message Not Accepted

88
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Section 4 — Message Structure — cont.
Transport Header

> This header is required to allow the transmission of messages longer
than the 255 octets allowed in one frame.

»The header is a single octet between the Data link Header CRC and
the application data

»FIN = Indicates the final frame in a sequence (1 bit)

»FIR = Indicates the first frame in a sequence (1 bit)

»Seqguence = Indicates the sequence number of each frame (6 bits)

N N I 5 I
9
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Section 4 — Message Structure — cont.

Transport Header

START LEN CTL DESTIN SOURCE CRC

oot o ot] cfwo] ef

DATA LINK HEADER
TH

oo e afw

r-'-" APPLICATION LAYER

\_ TRANSPORT Header
920
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Section 4 — Message Structure — cont.

Application Layer — User Data

»The application layer user data consists of three sections:
> The Application Header identifies the purpose of the message
»The Object Header identifies the type of data objects to follow
»>The Data is the actual data being transmitted in the message.

Application Object Header .
Header
91

Object Header m
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Section 4 — Message Structure — cont.

Application and Data Header

START LEN CTL DESTIN SOURCE CRC

et o ot] cf o] uf

DATA LINK HEADER
TH AC FC OBJVAR QUA

oo e afw

\ \- DATAHEADER
APPLICATION LAYER HEADER
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Section 4 — Message Structure — cont.

Application Header — Request Message — Application Control

»FIN = Indicates the final fragment in a sequence (1 bit)
»FIR = Indicates the first fragment in a sequence (1 bit)
»CON = Indicates the sending application expects a confirmation (1 bit)
»Seguence = Indicates the sequence number of each fragment (5 bits)

TH AC FC

oofcrf o] refoefue

SEQUENCE

93
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Section 4 — Message Structure — cont.

Application Header — Request Message — Function Code

> The function code indicates the function of the application request
> This can include (but is not limited to)
»See a copy of the DNP Basic 4 for a list of all function codes

TH AC FC

oof ] o ] 2o

Function Code

SSD0006 Revision5 © 2004 General Electric Canada, All Rights Reserved imagination at work @

94



Section 4 — Message Structure — cont.

Data Header

»The data header indicates the type of data that is to follow.
> There are three components to the header:
»QObject = indicates the type of data object
»>Variation = indicates the variation of the data object
»>Qualifier = indicates the range of data that will be presented
»See the Basic 4 for details on all objects, variations and qualifiers

OBJ VAR QUA
ooo) e afs

\- DATAHEADER
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Section 4 — Message Structure — cont.

Data Header - Qualifier

»Determines how data objects will be addressed in the Range Field:
> The first bit is reserved, and will always be 0
»Index Size = indicates the size of the index prefixing the data objects
»Qualifier Code = indicates the size and format of the range field.

TH AC FC OB V

EECGEO

Index Size (3 bits) Qualifier Code (4 bits)
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Section 4 — Message Structure — cont.

Data Header — Qualifier — Example 1

»Index = 0x — Data is not prefixed by an index field

»Qualifier = 6x — There is no Range field

> This combination implies that all data for the requested object will be
reported.

I Index Size (0) Qualifier Code (6)

TH AC FC OBJVAR QUA

aoo) e afs
97
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Section 4 — Message Structure — cont.

Data Header — Qualifier — Example 2

»Index = Ox — Data is not prefixed by an index field

»Qualifier = 1x — 16 bit Start and Stop range field

»The range field will indicate the first and last point to be reported. All
points within the range are reported in order.

I Index Size (0) Qualifier Code (1)

5 more
Startof Stopof  Object0  Object1 Objects
Range Range Data Data oo e o ° o eoceoe >

TH AC FC OBJVAR QUA A b i A= D

oo or)o) e aforfufwfosfoo] | | ] ] ]
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Section 4 — Message Structure — cont.

Data Header — Qualifier — Example 3

»Index = 1x — Data is prefixed by a one octet index field

»Qualifier = 7x — 8 bit quantity in the range field

»The range field will indicate the first and last point to be reported. All
points within the range are reported in order.

I Index Size (0) Qualifier Code (1)

Object 0 Data Object 1 Data
TH AC FC OBJVAR QUA QTY IN0 Ay N1 A

e[ afo[o[w[ T T [«] T ] JEE
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Section 4 — Message Structure — cont.

Application Header — Response Message

»The application header for a response message is different that that of a
request message.

»A 16 bit Internal Indication (IIN) is installed after the function code and
before the Data Header

TH AC FC OBJ VAR QUA

Hﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂ

k— Internal Indications
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Section 4 — Message Structure — cont.

Application Header — Response Message — Internal Indications

»The internal indication field breaks into 16 flags each indicating a different
condition in the RTU.
»>Refer to the DNP Basic 4 for a full list of all internal indications.

TH AC FC IIN OBJ VAR QUA

oo [ ofeo o Je [ forJo o [r e ] oo | | o G
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Section 4 — Message Structure — cont.

Review Questions
1. Describe the components of the Data Link Header.

2. What is the function of the Transport Header?

3. Describe the components of the Application Header,
iIncluding the data header and IIN.

4. What do each of the 16 bits in the IIN represent?

List at least 3 request and 2 response function
codes.

®
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DNP Parsing
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DNP Parsing

Objective:
The objective of this lab is to identify and parse
several DNP messages.

Introduction:

This lab will consist of several sections:

1. Parse pre-captured DNP messages.

2. Use SA Com to locate a class 123 scan and
response and parse the messages.

3. Use SA Com to locate an integrity scan and
response and parse the messages.

104
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DNP Parsing — cont.

Procedure 1: Pre-captured Messages

1. Select two of the six messages from the
supplementary training materials.

2. Using the parsing work sheets, parse the DNP
message.

105
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DNP Parsing — cont.

Procedure 2: Class 123 Scan

1. Using the configuration created in LAB1, capture
30 seconds worth of communication.

2. Locate a class 123 scan and response in the
communications capture.

3. Parse the class 123 scan.

106

SSD0006 Revision5 © 2004 General Electric Canada, All Rights Reserved imagination at work @



DNP Parsing — cont.

Procedure 3: Integrity Scan

1. Using the configuration created in LAB1, capture 2
minutes worth of communication.

2. Locate an integrity scan and response in the
communications capture.

3. Parse the integrity scan.

107
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We’re done!



